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 EXPRESSION WEB 4 ADD-IN 
BASICS  

     Add-ins in Expression Web  
 No software application can meet all needs for all people. No matter how 

many features Microsoft packs into Expression Web, there will always 

be designers who find that something’s missing. Fortunately, Expression 

Web is extensible so that users of the application can add functionality.  

 Previous versions of Expression Web were extensible only using a tech-

nology called Component Object Model, or COM. Using Visual Studio, 

Microsoft’s development studio, a developer can create a COM add-in that 

adds functionality to Expression Web. (If you’ve used any of my add-ins 

that I distribute from Jimco Software, 

you’ve used a COM add-in.) There is 

a significant barrier to entry for COM 

add-in development, and most web 

designers don’t possess the skill set 

necessary to develop them.   
 Expression Web 4 still allows for COM 

add-ins, but it adds an exciting new 

add-in architecture that allows web designers to use existing skills in 

HTML, XML, and JavaScript to develop add-ins. HTML is used to create 

user-interfaces, and JavaScript is used to add functionality to Expression 

Web 4 add-ins.  

    ➥   For more information on adding functionality to an add-in using 

JavaScript, see “Adding Functionality with JavaScript,” in the online 

Chapter 37 on page 673.           

 note 
 You can view a tutorial on 
how to create a COM add-in at 
 http://jimcobooks.com/arti-
cles/061130/Default.aspx .  
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 In this book, I cover everything you need to know to build add-ins 

using the new JavaScript and HTML extensibility model. I also 

cover the basics of how you can call into a COM add-in from a 

JavaScript add-in.   

  Expression Web 4 JavaScript Add-
ins  

 Using the JavaScript add-in model in Expression Web 4, you can 

create add-ins with three different main components: panels, dia-

log boxes, and commands.  

 Panels are available from the Panels menu. The interface for the 

panel is developed using HTML code, and functionality is pro-

vided using JavaScript. Panels open as floating panels, but users 

of the add-in can drag and drop the panel to dock it if desired.  

 Dialog boxes are displayed as a modal dialog of a specific size. 

The dialog box interface is developed using HTML, and func-

tionality is provided using JavaScript. JavaScript can be used to 

control the functionality of the dialog box itself as well as add 

functionality for the add-in.  

 Commands add a menu command or a toolbar button that runs 

JavaScript code when the menu item or toolbar button is clicked. 

Commands are also used to launch dialog boxes.   
 You may already be familiar with using JavaScript to add func-

tionality to a web page running inside a browser. When you use 

JavaScript to develop Expression Web add-ins, you are not inter-

acting with a web page in the browser. Instead, you are using JavaScript to interact with files (web 

pages and other files) inside the Expression Web interface. You can also use JavaScript to interact 

with Expression Web itself.  

 I’ll explain how to do all of that in the next few chapters, but before we get into the details of imple-

menting an add-in, it’s important to understand some of the basics that make up an Expression Web 

add-in.  

  The Makeup of Expression Web Add-ins  
 Expression Web add-ins are made up of a collection of files. 

HTML files are used to present a user interface for panels and 

dialog-boxes. JavaScript code is often included directly in the 

HTML file, but can also be included as a separate script file with 

a  .js  file extension. Add-ins can also include any number of col-

lateral files such as image files, CSS files, and so on.   

 note 
 Microsoft intends for JavaScript 
add-ins to be used with disk-
based sites only. If you use a 
JavaScript add-in with a server-
based site accessed using HTTP 
or FTP, you may encounter unex-
pected results.  

 I’ll provide guidance on what you 
can expect with server-based 
sites in  Chapter   39   , “Expression 
Web 4 JavaScript API Reference.”  

 tip 
 Microsoft’s documentation says 
that there are three types of add-
ins: panel, dialog box, and com-
mand add-ins. However, since 
it’s possible for a single add-in 
to have any combination of those 
three, I believe it’s more accurate 
to call these components of an 
add-in and not refer to them as 
types of add-ins.  

 tip 
 Since add-ins can be created 
right from within Expression 
Web, the easiest way to create 
an add-in is to create a new disk-
based site and then create your 
add-in files within that site.  
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 Add-ins also contain a special XML file called a  manifest . The add-in manifest (named  addin.xml ) 

describes the add-in to Expression Web. It’s used to tell Expression Web the components included 

with the add-in, the files included with the add-in, and other information necessary for the proper 

functioning of the add-in. The manifest also includes information such as the add-in’s name, the 

name of the developer, the version number, and so on.  

  Listing   36.1    shows a simple add-in manifest for an add-in that displays a panel.  

  Listing 36.1 A Simple Manifest File  

 <addin>
    <name>Simple Panel</name>
    <version>1.0</version>
    <description>A simple panel add-in for Expression Web.</description>
    <author>Jim Cheshire</author>
    <homepage>http://www.jimcosoftware.com</homepage>
    <panel src=”default.html” id=”panel1”
          title=”Simple Panel” filetype=”HTML-DOM”
          activate=”enableControls” deactivate=”disableControls” />
  </addin>   

 Add-in files can be saved into any folder, but the manifest must be inside the root folder for the 

add-in. Once you’re ready to use an add-in, you simply Zip the folder where the files are located and 

then rename the Zip file so that it has a  .xadd  file extension. You can then install the add-in using 

the Add-ins dialog available by selecting Tools, Add-ins in Expression Web.  

 I’ll cover all of this in explicit detail in the next few chapters, but what I want you to take away 

from this is that no specialized tools or complicated skill sets are required to create and deploy 

Expression Web 4 add-ins. You can create them right inside Expression Web, and you can create an 

installable package by simply renaming a Zip file. It really couldn’t be simpler.    

  XML Basics  
 Before I go into the details of the add-in manifest, you’ll need to know some basics about XML. XML 

syntax is actually used for the XHTML code with which you are probably at least somewhat familiar.  

 At the top level of an XML file is the  root element . There is exactly one root element; no fewer, no 

more. Beneath the root element are  child elements . There can be any number of child elements in an 

XML file, and each child element can also have its own child elements. The element directly above a 

child element is known as the  parent element .  

 In the manifest in  Listing   36.1   , the  <addin>  element is the root element. All other elements are child 

elements.   
 All elements may contain one or more  attributes . An attribute is 

defined within the XML element itself and consists of the attribute 

name followed by the attribute value in quotes. The following line 

of XML shows an attribute called  developer  with a value of  yes .  

  <addin developer=”yes”>   

 caution 
 XML is case-sensitive, so pay 
attention to case when writing 
XML.  
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 Attribute names are case-sensitive, and attribute values must be 

enclosed in quotes.   
 All child elements in an XML file may contain attributes or text 

content. Text content is textual information surrounded by a par-

ticular element. In the XML code that follows,  Simple Panel  is 

the text content for the  <name>  element.  

  <name>Simple Panel</name>    

 The  <  and  &  characters are not legal characters for XML content. 

If you want to use these characters for attribute or text content, 

you need to use what’s called an  entity reference . The entity ref-

erence for  <  is  &lt;  and the entity reference for  &  is  &amp; . You 

might notice that both entity references contain the  &  character. 

The only time the  &  character is valid in an XML file is when it is 

used with an entity reference.  

 The following XML snippet defines a name of Jack & Jill Add-ins.  

  <name>Jack &amp; Jill Add-ins</name>   

 Armed with this basic information about XML, you are now ready 

to learn the details about the add-in manifest. This chapter covers all the elements and attributes 

that you can use in an add-in manifest. Later chapters go into much more detail about how to use 

specific elements and attributes.    

  General Manifest Elements and Attributes  
 As mentioned previously, the  <addin>  element is the root ele-

ment of the add-in manifest. Four optional attributes are available 

for the  <addin>  element.   

   src  (optional)  
  <addin  src =’script.js’>   

 The  src  attribute is used to specify JavaScript source files that 

contain functions that the manifest references. This attribute is 

typically used for commands that don’t have a user interface. Scripts that are used with panels and 

dialog boxes are referenced within the HTML files used with those components.  

 Source file paths are relative to the add-in’s top-level folder, and you can add multiple source files by 

separating them with a comma.   

 tip 
 Some XML files use camel case 
for attribute names. However, in 
an add-in manifest, all attribute 
names are lowercase.  

 note 
 An XML element can contain both 
attributes and text content.  

 note 
 If you’d like more information 
about XML, read Special Edition 
Using XML from Que Publishing.  

 tip 
 Each element and attribute docu-
mented in the following sections 
includes a graphical representa-
tion of where that particular ele-
ment or attribute fits within the 
manifest’s hierarchy.  
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   legacy  (optional)  
  <addin  legacy =’yes’>   

 The  legacy  attribute is set to  yes  when an add-in needs to access the legacy object model for 

Expression Web. The legacy object model provides access to the object model used by add-in devel-

opers in previous versions of Expression Web, and it has some additional functionality compared to 

the JavaScript API.  

 Use of the legacy object model is outside the scope of this book.   

   developer  (optional)  
  <addin  developer =’yes’>   

 When set to  yes , the  developer  attribute aids in testing and 

troubleshooting your add-in during development. By default, the 

context menu that appears when you right-click on a page is dis-

abled for add-in panels and dialog boxes. By including the  devel-

oper  attribute with a value of  yes , you can remove this restriction, 

allowing you to easily refresh the user interface of your panel or 

dialog box, view the source of your interface, and so on.  

 There are other benefits to setting the  developer  attribute to  yes  

when you are developing your add-in. I’ll cover how you can use 

developer mode to debug your add-in in  Chapter   39   .    

   navigationallowed  (optional)  
  <addin  navigationallowed =’yes’>   

 By default, Expression Web does not allow you to navigate away from the current page from within 

a panel or a dialog box. For example, if your dialog box contains a hyperlink, clicking the hyperlink 

does nothing by default.  

 In some situations, it may be necessary to allow a user of your add-in to navigate to other pages 

within your add-in’s user interface. For example, if your add-in’s interface is in the form of a wizard, 

you may want to implement each step of the wizard using a separate page. In such a scenario, set-

ting the  navigationallowed  attribute to  yes  allows a user to navigate through the pages of your 

wizard.   

 note 
 You should not set the  devel-
oper  attribute to  yes  unless 
you are in the process of devel-
oping your add-in because doing 
so enables debugging tools that 
are not meant for end-users.  
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  < name>  (required)  
  <addin>
     < name =’My Add-in’/>   

 The  <name>  element specifies the name of your add-in. Once your add-in is installed into Expression 

Web, the value specified by the  <name>  attribute is displayed in the Manage Add-ins dialog as 

shown in  Figure   36.1   .    

 Figure 36.1 
 The name shown in the Manage 
Add-ins dialog is controlled by the 
 <name>  element. This add-in uses 
the manifest shown in  Listing   36.1   .        

   <description>  (optional)  
  <addin>
     < description =’Simple Add-in’/>   

 The  <description>  element is used to provide a description of your add-in that appears in the 

Manage Add-ins dialog as shown previously in  Figure   36.1     

 The  <description>  element is optional, but it’s a good idea to include it so that users of your add-

in can more easily identify it inside the Manage Add-ins dialog.   

   <author>  (optional)  
  <addin>
     < author =’Jim Cheshire’/>   
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 The  <author>  element provides a means of displaying the add-in author’s name in the Manage 

Add-ins dialog.   

   <version>  (optional)  
  <addin>
     < version =’1.0.21.12’/>   

 The  <version>  element allows for the inclusion of a version number for your add-in, and the value 

specified here is displayed in the Manage Add-ins dialog. The format of the version number is 

#.#.#.# where the first number is the major version and the others are minor version numbers.  

 If you include a  version  element, the major version number is required and minor version numbers 

are optional.   

   <homepage>  (optional)  
  <addin>
     < homepage =’www.jimcobooks.com’/>   

 The  <homepage>  element allows you to include a URL where users of your add-in can get additional 

information. The URL you specify is included in the Manage Add-ins dialog, but it is not displayed 

as a clickable link.   

   <minversion>  (optional)  
  <addin>
     < minversion =’4.5’/>   

 The  <minversion>  element is used to specify the minimum version of Expression Web that is 

required to use your add-in. The version number is specified using the same syntax used with the 

 <version>  element.  

 In the current version of Expression Web, the  <minversion>  element is ignored.   

   <guid>  (optional)    
  <addin>
     < guid =’a85b04a4-1176-4ef6.../>   

 The  <guid>  element is used to specify a unique identifier for your 

add-in in the form of a GUID. The current version of Expression 

Web doesn’t use this element, but it may be used in the future for 

helping with upgrading add-ins.    

 tip 
 You can use the page at  www.
guidgen.com  to generate a GUID 
for your add-in.  

37_9780789749192_ch36.indd   62137_9780789749192_ch36.indd   621 5/31/12   10:33 AM5/31/12   10:33 AM



Expression Web 4 Add-in Basics622

8

PA
R

T

   <load>  (optional)  
  <addin>
     < load  type=”MyNs.MyAddin, MyNS” name=”myAsmbly”/>   

 The  <load>  element is used to load a  managed   assembly  (a .NET Framework DLL) that can add 

additional functionality to your add-in.  

 The  <load>  element has two attributes. The  type  attribute specifies the namespace and class 

name of your managed class along with the  assembly  (the DLL file) that contains the class. The 

 name  attribute specifies the JavaScript namespace you want to use to access the managed class 

from JavaScript.  

 The following  <load>  element loads a class called  ManagedNamespace.UtilClass  in an assem-

bly called  myClass.dll . Functions in  UtilClass  can be called from JavaScript using the  util  

namespace.  

  <load type=”ManagedNamespace.UtilClass, myClass” name=”util” />   

 I cover calling managed classes from JavaScript in much more detail in  Chapter   37   , “Creating a 

Basic Add-in,” so if this is somewhat confusing to you at this point, don’t worry.    

    ➥   For more information on accessing managed classes from JavaScript, see “Accessing Managed 

Classes from JavaScript,” in the online Chapter 37 on page 682.            

  Commands and Dialog Boxes  
 As mentioned previously, a command is a menu item or a toolbar item that runs a JavaScript func-

tion when clicked. A command can also be used to launch a dialog box. (Panels aren’t launched 

using a command because they are automatically added to the Panels menu in Expression Web.)  

 The  <command>  element is a child of the  <addin>  element, and it has three attributes.  

   id  (required)  
  <addin>
     <command  id =’MyAddinCommand’>   

 The  id  attribute is a unique string that identifies the command. 

Expression Web uses the  id  attribute to correctly identify your 

command and respond to a user interacting with it.    

   filetype  (optional)  
  <addin>
     <command  filetype =’HTML-DOM’>   

 tip 
 It’s a good idea to use a value 
such as part of your name in your 
ID so that you don’t end up using 
the same ID as another add-in. 
For example, if I use MetaTag as 
the ID of my command, it’s pos-
sible that another add-in devel-
oper might use the same value. 
However, if I use JimcoMetaTag 
as my ID, it’s almost certainly 
going to be unique in all cases.  
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 It’s likely that your add-in will target specific types of files. For 

example, if your add-in is designed to generate HTML code for web 

pages, you wouldn’t want users to be able to access your add-in 

when a CSS file is active in Expression Web.   
 The  filetype  attribute allows you to define which types of 

files are valid for your add-in. If the type of file that is active in 

Expression Web matches a type specified in the  filetype  attri-

bute, any menu items or toolbar buttons for the command are 

enabled. Otherwise, they are disabled.   
 The following are valid values for the  filetype  attribute:  

    •   HTML—     A file that has a  .htm  or  .html  file extension.   

   •   PHP—     A PHP page with a  .php  file extension.   

   •   ASP—     An ASP or ASP.NET page. File extensions can be  .asp , 

 .aspx ,  .asmx , or  .ascx .   

   •   CSS—     A style sheet file with a  .css  file extension.   

   •   JS—     A JavaScript file with a  .js  file extension.   

   •   HTML-DOM—     Any file that contains an HTML DOM. For exam-

ple, any  .aspx  file,  .php  file,  .htm  file, and so on.   

   •   TXT—     A file with a  .txt  file extension.   

   •   XML—     A file with a  .xml  file extension.    

 You can specify multiple file types by separating multiple values with a comma.   

   onclick  (optional)  
  <addin>
     <command  onclick =’myFunction() ‘>   

 The  onclick  attribute is used to run a JavaScript function or expression when a command’s menu 

item or toolbar button is clicked. The  onclick  attribute can refer to a function inside an HTML file 

when using a dialog box or within a JavaScript file specified by the  src  attribute of the  <addin>  

element.  

 If your add-in uses a dialog box, the  onclick  method is used to launch the dialog box by calling the 

method  xweb.application.showModalDialog . In the following example, the  onclick  attribute 

specifies that a dialog box will be displayed that contains the contents of  default.html , is titled 

My Dialog, has a width of 400 pixels and a height of 600 pixels, and is resizable and scrollable.  

  <command id=”myDialog”
      onclick=”xweb.application.showModalDialog(‘default.html’, ‘My Dialog’,
      ‘dialogwidth:400; dialogHeight:600; resizable:yes; scroll:yes’)”>   

 tip 
 If you don’t specify a value 
for the  filetype  attribute, 
menu items or toolbar items for 
your command will always be 
enabled.  

 note 
 Keep in mind that the 
 filetype  attribute of the 
 <command>  element doesn’t 
affect whether a panel’s menu 
item is enabled or disabled. 
Panels are completely separate 
from commands. I’ll cover panels 
later in this chapter.  
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     Menus and Toolbars  
 As mentioned earlier, panels are launched using the Panels menu 

in Expression Web. However, to run commands or launch dialog 

boxes, you need to add a menu item or a toolbar button (or both) 

for your add-in. Menu items are added using the  <menuitem>  ele-

ment, and toolbar buttons are added using the  <toolbaritem>  

element, both of which are child elements of the  <command>  ele-

ment.  

   <menuitem>  (optional)  
  <addin>
     <command>
        < menuitem >   

 The  <menuitem>  element is a child of the  <command>  ele-

ment and is used to add a menu item to an existing menu in 

Expression Web. Expression Web will then control whether the 

menu item is enabled based on the  filetype  attribute in the 

 <command>  element. When the menu item is clicked, the function 

or expression you specified in the  onclick  attribute of the  <com-

mand>  element will be executed.   
 The  <menuitem>  element has five available attributes.  

   parent  (required)  
  <addin>
     <command>
        <menuitem  parent =’MENU_Tools’>   

 The  parent  attribute is used to specify which menu in Expression Web should contain your menu 

item. The value specified for the  parent  attribute is the internal ID used by Expression Web for the 

menu. The internal ID is in the format of  MENU_  followed the name of the menu. For example, the 

internal ID of the File menu is  MENU_File .  

 Unless you also include a value for the  before  attribute, your command’s menu item appears last on 

the menu that you specify.  

    ➥   For a complete reference of internal IDs for Expression Web menus, see “Menu and Command 

Bar Reference,” p. 630, later in this chapter.     

 tip 
 You may be wondering what you 
should click to cause the func-
tion or expression specified in 
the  onclick  attribute to run. I’ll 
cover that in the next section.  

 tip 
 It’s not uncommon for an add-in 
to define a menu item and a tool-
bar item for the same command.  
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   before  (required)  
  <addin>
     <command>
        <menuitem  before =’MENU_Tools_AddIns’>   

 The  before  attribute allows you to specify where to place your menu item on the menu that you 

specified using the  parent  attribute. The value used for the  before  attribute is the internal ID of 

a menu item. The format is typically the internal ID of the menu followed by the text of the menu 

item. For example, the internal ID of the Save item on the File menu is  MENU_File_Save .  

 Menus also have horizontal bars that separate groups of menu 

items. The internal IDs of these separator bars don’t follow the 

naming convention of other menu items. However, you can refer to 

the “Menu and Command Bar Reference” section at the end of this 

chapter to find the internal ID for them.      

   label  (required)  
  <addin>
     <command>
        <menuitem  label =’Cool &amp;Add-in’>   

 The  label  attribute is used to set the text that appears on the 

menu item for your add-in. When specifying a value for the  label  

attribute, you should always define a hotkey for your menu item so 

that it is accessible for all users. To define a hotkey, add an under-

score prior to the letter you want to use for the hotkey.    

   imagesrc  (optional)  
  <addin>
     <command>
        <menuitem  imagesrc =’MyAddin.png’>   

 If you’d like for your menu item to include an image, specify the 

path to the image using the  imagesrc  attribute. The image you 

specify appears to the left of the menu item, and it must be 16 pix-

els by 16 pixels and either JPG or PNG file format. Expression Web 

does not support JPEG 2000 format, so PNG is the only option if 

you need a transparent background.    

 tip 
 There’s no guarantee that your 
menu item will appear exactly 
where you specify. For example, 
if two add-ins are installed and 
both specify that a menu item 
should appear before Save on 
the File menu, the last one to 
load appears before Save, and 
the other add-in’s menu item is 
bumped up one position on the 
File menu.  

 tip 
 Hotkeys appear underlined when 
the Alt key on the keyboard is 
pressed. Users can select menus 
and menu items by pressing the 
hotkey after pressing Alt.  

 tip 
 It’s best to use PNG for your 
menu item’s image so that you 
can take advantage of transpar-
ency. Expression Web allows a 
user to use his or her Windows 
color scheme so you can’t predict 
the background color of menus 
in Expression Web. If you use 
PNG with transparency when you 
save your menu item’s image, it 
looks more professional.  
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   tooltip  (optional)  
  <addin>
     <command>
        <menuitem  tooltip =’Insert a Widget’>   

 The  tooltip  attribute is used to specify the text that should appear in the pop-up tooltip when a 

user hovers the mouse over your menu item. The tooltip should concisely describe what the menu 

item does.    

  < toolbaritem>  (optional)  
  <addin>
     <command>
        < toolbaritem >   

 The  <toolbaritem>  element is a child of the  <command>  element and is used to define a toolbar 

button on a toolbar. When the toolbar button is clicked, the function specified in the  onclick  attri-

bute of the  <command>  element is executed.  

 The  <toolbaritem>  element has five attributes.  

   parent  (required)  
  <addin>
     <command>
        <toolbaritem  parent =”COMMANDBAR_Standard”>   

 The  parent  attribute specifies which Expression Web toolbar 

will contain your add-in’s toolbar item. The value you assign to 

the  parent  attribute is in the format  COMMANDBAR_  followed by 

the name of the toolbar.  

 To find the name you should use for a specific toolbar, right-

click on a toolbar in Expression Web. The name used for the 

 parent  attribute is the name you see on the context menu, 

but you need to remove any spaces. For example, to add your 

toolbar item to the Style Application toolbar, use  COMMANDBAR_

StyleApplication  for the  parent  attribute.    

   before  (optional)  
  <addin>
     <command>
        <toolbaritem  before =”COMMANDBAR_Common_Save”>   

 The  before  attribute controls where your toolbar item appears on the toolbar specified in the  par-

ent  attribute. Your toolbar item appears before the item identified by the  before  attribute.  

 tip 
 You can create your own 
toolbar for your toolbar item 
by specifying a toolbar name 
that doesn’t already exist. For 
example, to create a new tool-
bar called MyToolbar, use the 
value  MyToolbar  for the  par-
ent  attribute. Spaces are not 
allowed.  
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 The value for the  before  attribute is typically the value of the  parent  attribute followed by an 

underscore and the name (without spaces) of the toolbar item before which your toolbar item should 

appear. Toolbars have vertical separator bars between groups of buttons, and you can use the inter-

nal ID of one of these separators for the  before  attribute as well.  

    ➥   For a complete reference of internal IDs for Expression Web menus, see “Menu and Command 

Bar Reference,” p. 630, later in this chapter.     

   label  (optional)  
  <addin>
     <command>
        <toolbaritem  label =”Add Widget”>   

 Use the  label  attribute to set a text label for your toolbar item. A toolbar item can appear either 

as text or an image. If you want your item to appear as text, specify a value for  label  and do not 

specify a value for the  imagesrc  attribute.   

   imagesrc  (optional)  
  <addin>
     <command>
        <toolbaritem  imagesrc =”addinitem.png”>   

 Use the  imagesrc  attribute when using an image for your toolbar item. The image should be 16×16 

pixels and either in PNG or JPEG format.  

 Because a toolbar item can be either a text button or an image button, if a value is specified for the 

 imagesrc  attribute, a value specified for the  label  attribute will be ignored.   

   tooltip  (optional)  
  <addin>
     <command>
        <toolbaritem  tooltip =”Insert Widget”>   

 The  tooltip  attribute allows you to add a textual tooltip that appears when a user hovers the 

mouse over your toolbar item.     

  Panels  
 If your add-in’s user interface is around 275 or fewer pixels wide, it may be suitable for a panel 

instead of a dialog box. Panels are defined using the  <panel>  element.  
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   <panel>  (optional)  
  <addin>
     < panel >   

 The  <panel>  element defines a panel that can be opened using the Panels menu. Panels are 

floating by default, but a user can dock the panel by dragging and dropping it to an edge in the 

Expression Web interface.  

 The  <panel>  element has nine attributes.  

   id  (required)  
  <addin>
     <panel  id =”MyPanel”>   

 The  id  is a unique value that identifies your panel to Expression Web. Just as with the value used 

for the  id  attribute of the  <command>  element, you should ensure that the value is unique by includ-

ing a common string not likely to be included by another add-in developer.   

   title  (required)  
  <addin>
     <panel  title =”My Add-in”>   

 The value given for the  title  attribute appears on both the Panels menu and also in the tab for 

your panel. Just as with menu items, you can use an underscore to define a hotkey for your panel’s 

menu item on the Panels menu.   

   src  (required)  
  <addin>
     <panel  src =”panel.htm”>   

 The  src  attribute is used to specify the web page that contains the source for your panel’s user 

interface.   

   filetype  (optional)  
  <addin>
     <panel  filetype =”HTML-DOM”>   

 The  filetype  attribute is used to specify when the function or expression that is specified for the 

 activate  and  deactivate  attributes will run. When assigning a value to the  filetype  attribute, 

use one of the same values I defined previously for the  filetype  attribute of the  <command>  ele-

ment.   
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   activate  (optional)  
  <addin>
     <panel  activate =”activatePanel()”>   

 Expression Web allows users to open a panel at any time. Therefore, to control whether a user can 

interact with your panel, you need to control whether the controls in your panel’s user interface are 

enabled.  

 Use the  filetype  attribute to specify which page type is applicable for your panel. You can then 

use the  activate  attribute to specify a JavaScript function or expression that enables the necessary 

control in your panel’s interface.   

   deactivate  (optional)  
  <addin>
     <panel  deactivate =”deactivatePanel()”>   

 The  deactivate  attribute is used to deactivate your panel’s user interface when the page that is 

open in Expression Web doesn’t match a type specified by the  filetype  attribute. Just as with the 

 activate  attribute, the value for the  deactivate  attribute is a JavaScript function or expression.   

   ondocumentchanged  (optional)  
  <addin>
     <panel  ondocumentchanged =”resetPanel()”>   

 The  activate  and  deactivate  attributes can be used to con-

trol two states of your panel: active and inactive. However, your 

panel’s user interface may also need to be updated in other situa-

tions. The  ondocumentchanged ,  ondocumentsaved , and  onele-

mentchanged  attributes are available for controlling your panel’s 

interface in other situations.  

 The  ondocumentchanged  attribute allows you to specify a 

JavaScript function or expression that executes when the page or 

file that is open in Expression Web is changed to a new page or a 

different page. You might, for example, want to use the  ondocu-

mentchanged  attribute to specify a JavaScript function that resets 

your panel’s user interface to its initial state.    

 note 
 The name  ondocu-
mentchanged  makes you think 
that changing some content 
in the active document causes 
the function or expression you 
specify to execute. In fact, chang-
ing the content isn’t what causes 
a document change event. It’s 
actually changing the document 
itself that causes the  ondocu-
mentchanged  attribute to 
come into play.  
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   ondocumentsaved  (optional)  
  <addin>
     <panel  ondocumentsaved =”cleanPanel()”>   

 If you require that your panel’s interface react to the active document being saved, you can use the 

 ondocumentsaved  attribute to specify a JavaScript function or expression that should run when the 

document is saved.   

   onelementchanged  (optional)  
  <addin>
     <panel  onelementchanged =”evalPanel()”>   

 It’s possible that your panel might not be usable for any element 

on a page. For example, if your panel is designed to work with 

HTML tables, it doesn’t make sense for your panel to be available 

for user interaction unless a table is active in Expression Web. 

The  onelementchanged  attribute is designed to handle just such 

a situation.   
 By specifying a JavaScript function or expression in the  onele-

mentchanged  attribute, you can determine whether the selected 

element is applicable to your panel and react accordingly.    
 Once you have an understanding of the add-in manifest, you have 

all the skills necessary to create menu items and toolbar buttons, 

control when those menu items and toolbar buttons are enabled 

or disabled, create panels, and much more.  

 In the next few chapters, you learn how to control the user 

interface of your panels and dialog boxes and how to program-

matically interact with Expression Web and the web pages open 

within it.     

  Menu and Command Bar 
Reference  

 When defining menu items and toolbar items in your manifest 

file, it’s necessary to know the internal ID of Expression Web’s 

menu items and toolbar items. The following reference allows you to determine the correct value for 

your  parent  and  before  attributes.  

 note 
 An element is a representation of 
an HTML tag in a page.  

 tip 
 If you need to enable or disable 
your panel based on the selected 
element, you can usually use 
the same JavaScript function 
or expressions used for the 
 activate  and  deactivate  
attributes.  

 caution 
 As a user is editing a document 
in Expression Web, the  onele-
mentchanged  event happens 
often. To prevent performance 
problems, make sure that the 
JavaScript function or expression 
you specify for the  onele-
mentchanged  attribute is light-
weight.  

37_9780789749192_ch36.indd   63037_9780789749192_ch36.indd   630 5/31/12   10:33 AM5/31/12   10:33 AM



631Menu and Command Bar Reference

36

C
H

A
P

TER

  Menus  
 The following tables list the internal IDs of all menus and menu items in Expression Web. Use the 

value specified in the Parent column for the  parent  attribute and the value in the Internal ID col-

umn for the  before  attribute in your manifest file.  

  Table   36.1    shows the internal IDs of all items on the File menu.  

  Table   36.2    lists the internal IDs of items on the Edit menu.  

  Table   36.3    lists the internal IDs of items on the View menu.  

  Table   36.4    lists the internal IDs of items on the Insert menu.  

  Table   36.5    lists the internal IDs of items on the Format menu.  

  Table   36.6    lists the internal IDs of items on the Tools menu.  

  Table   36.7    lists the internal IDs of items on the Table menu.  

  Table   36.8    lists the internal IDs of items on the Site menu.  

  Table   36.9    lists the internal IDs of items on the Data View menu.  

  Table   36.10    lists the internal IDs of items on the Window menu.  

  Table   36.11    lists the internal IDs of items on the Help menu.  

  Table 36.1   File Menu Internal IDs  

 Parent   Menu Item   Internal ID  

 N/A   File    MENU_File   

  MENU_File    New    MENU_File_New   

  MENU_File_New    Page...    MENU_File_New_Page   

  MENU_File_New    [Separator]    Separator_1   

  MENU_File_New    HTML    MENU_File_New_HTML   

  MENU_File_New    ASPX    MENU_File_New_ASPX   

  MENU_File_New    ASP    MENU_File_New_ASP   

  MENU_File_New    PHP    MENU_File_New_PHP   

  MENU_File_New    CSS    MENU_File_New_CSS   

  MENU_File_New    [Separator]    Separator_2   

  MENU_File_New    Folder    MENU_File_New_Folder   

  MENU_File_New    [Separator]    Separator_3   

  MENU_File_New    Create from 
Dynamic Web 
Template...  

  MENU_File_New_
CreateFromDynamicWebTemplate   

  MENU_File_New    Create from 
Master Page...  

  MENU_File_New_
CreateFromMasterPage   

  MENU_File    Open...    MENU_File_Open   
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 Parent   Menu Item   Internal ID  

  MENU_File    Recent Files    MENU_File_RecentFiles   

  MENU_File    Close    MENU_File_Close   

  MENU_File    [Separator]    Separator_4   

  MENU_File    Save    MENU_File_Save   

  MENU_File    Save As...    MENU_File_SaveAs   

  MENU_File    Save All    MENU_File_SaveAll   

  MENU_File    [Separator]    Separator_5   

  MENU_File    Import    MENU_File_Import   

  MENU_File_Import    File...    MENU_File_Import_File   

  MENU_File_Import    Adobe Photoshop 
( .psd )...  

  Menu_File_Import_
AdobePhotoshopPSD   

  MENU_File    [Separator]    Separator_6   

  MENU_File    Display in 
SuperPreview  

  MENU_File_PreviewInBrowser_
OpenInSuperPreview   

  MENU_File    Preview in 
Browser  

  MENU_File_PreviewInBrowser   

  MENU_File_PreviewInBrowser    Preview in 
Browser 1[-8]  

  MENU_File_PreviewInBrowser_1[-8]   

  MENU_File_PreviewInBrowser    [Separator]    Separator_7   

  MENU_File_PreviewInBrowser    Preview in 
Multiple Browsers  

  MENU_File_PreviewInBrowser_
PreviewInMultipleBrowsers   

  MENU_File_PreviewInBrowser    Preview in 
Multiple Browsers 
(640x480)  

  MENU_File_PreviewInBrowser_
PreviewInMutipleBrowsers640x480   

  MENU_File_PreviewInBrowser    Preview in 
Multiple Browsers 
(800x600)  

  MENU_File_PreviewInBrowser_
PreviewInMultipleBrowsers800x600   

  MENU_File_PreviewInBrowser    Preview in 
Multiple Browsers 
(1024x768)  

  MENU_File_PreviewInBrowser_
PreviewInMultipleBrowsers1024x768   

  MENU_File_PreviewInBrowser    [Separator]    Separator_7   

  MENU_File_PreviewInBrowser    Edit Browser 
List...  

  MENU_File_PreviewInBrowser_
EditBrowserList   

  MENU_File    Print    MENU_File_Print   

  MENU_File_Print    Print...    MENU_File_Print_Print   

  MENU_File_Print    Print Preview    MENU_File_Print_PrintPreview   

  MENU_File_Print    Page Setup...    MENU_File_Print_PageSetup   

Table 36.1 Continued
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 Parent   Menu Item   Internal ID  

  MENU_File    Properties...    MENU_File_Properties   

  MENU_File    [Separator]    Separator_9   

  MENU_File    Source Control    MENU_File_SourceControl   

  MENU_File    [Separator]    Separator_10   

  MENU_File    Exit    MENU_File_Exit   

  Table 36.2   Edit Menu Internal IDs  

 Parent   Menu Item   Internal ID  

 N/A   Edit    MENU_Edit   

  MENU_Edit    Undo    MENU_Edit_Undo   

  MENU_Edit    Redo    MENU_Edit_Redo   

  MENU_Edit    [Separator]    Separator_11   

  MENU_Edit    Cut    MENU_Edit_Cut   

  MENU_Edit    Copy    MENU_Edit_Copy   

  MENU_Edit    Paste    MENU_Edit_Paste   

  MENU_Edit    Paste Text...    MENU_Edit_PasteText   

  MENU_Edit    [Separator]    Separator_12   

  MENU_Edit    Delete    MENU_Edit_Delete   

  MENU_Edit    Select All    MENU_Edit_SelectAll   

  MENU_Edit    [Separator]    Separator_13   

  MENU_Edit    Find...    MENU_Edit_Find   

  MENU_Edit    Replace...    MENU_Edit_Replace   

  MENU_Edit    Incremental 
Search  

  MENU_Edit_IncrementalSearch   

  MENU_Edit    Go To...    MENU_Edit_DynamicLabel3   

  MENU_Edit    Quick Tag 
Editor  

  MENU_Edit_QuickTagEditor   

  MENU_Edit    [Separator]    Separator_14   

  MENU_Edit    Code View    MENU_Edit_CodeView   

  MENU_Edit_CodeView    Increase Indent    MENU_Edit_CodeView_IncreaseIndent   

  MENU_Edit_CodeView    Decrease Indent    MENU_Edit_CodeView_DecreaseIndent   

  MENU_Edit_CodeView    [Separator]    Separator_16   

  MENU_Edit_CodeView    Select Tag    MENU_Edit_CodeView_SelectTag   
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 Parent   Menu Item   Internal ID  

  MENU_Edit_CodeView    Find Matching 
Tag  

  MENU_Edit_CodeView_FindMatchingTag   

  MENU_Edit_CodeView    Select Block    MENU_Edit_CodeView_SelectBlock   

  MENU_Edit_CodeView    Find Matching 
Brace  

  MENU_Edit_CodeView_FindMatchingBrace   

  MENU_Edit_CodeView    [Separator]    Separator_17   

  MENU_Edit_CodeView    Insert Start Tag    MENU_Edit_CodeView_InsertStartTag   

  MENU_Edit_CodeView    Insert End Tag    MENU_Edit_CodeView_InsertEndTag   

  MENU_Edit_CodeView    Insert HTML 
Comment  

  MENU_Edit_CodeView_InsertHTMLComment   

  MENU_Edit_CodeView    Insert CSS 
Comment  

  MENU_Edit_CodeView_InsertCSSComment   

  MENU_Edit_CodeView    [Separator]    Separator_18   

  MENU_Edit_CodeView    Toggle 
Bookmark  

  MENU_Edit_CodeView_ToggleBookmark   

  MENU_Edit_CodeView    Next Bookmark    MENU_Edit_CodeView_NextBookmark   

  MENU_Edit_CodeView    Previous 
Bookmark  

  MENU_Edit_CodeView_PreviousBookmark   

  MENU_Edit_CodeView    Clear 
Bookmarks  

  MENU_Edit_CodeView_ClearBookmarks   

  MENU_Edit_CodeView    [Separator]    Separator_19   

  MENU_Edit_CodeView    Follow Code 
Hyperlink  

  MENU_Edit_CodeView_
FollowCodeHyperlink   

  MENU_Edit_CodeView    Previous Code 
Hyperlink  

  MENU_Edit_CodeView_
PreviousCodeHyperlink   

  MENU_Edit_CodeView    Next Code 
Hyperlink  

  MENU_Edit_CodeView_NextCodeHyperlink   

  MENU_Edit    IntelliSense    MENU_Edit_IntelliSense   

  MENU_Edit_IntelliSense    List Members    MENU_Edit_IntelliSense_ListMembers   

  MENU_Edit_IntelliSense    Parameter Info    MENU_Edit_IntelliSense_ParameterInfo   

  MENU_Edit_IntelliSense    Complete Word    MENU_Edit_IntelliSense_CompleteWord   

  MENU_Edit_IntelliSense    List Code 
Snippets  

  MENU_Edit_IntelliSense_
ListCodeSnippets   

Table 36.2 Continued
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  Table 36.3   View Menu Internal IDs  

 Parent   Menu Item   Internal ID  

 N/A   View    MENU_View   

  MENU_View    Page    MENU_View_Page   

  MENU_View_Page    Design    MENU_View_Page_Design   

  MENU_View_Page    Split    MENU_View_Page_Split   

  MENU_View_Page    Code    MENU_View_Page_Code   

  MENU_View_Page    [Separator]    Separator_20   

  MENU_View_Page    Snapshot    MENU_View_Page_Snapshot   

  MENU_View    Site    MENU_View_Site   

  MENU_View_Site    Folders    MENU_View_Site_Folders   

  MENU_View_Site    Publishing    MENU_View_Site_Publishing   

  MENU_View_Site    Site Summary    MENU_View_Site_SiteSummary   

  MENU_View_Site    Files    MENU_View_Site_Files   

  MENU_View_Site_Files    All Files    MENU_View_Site_Files_AllFiles   

  MENU_View_Site_Files    Recently Added 
Files  

  MENU_View_Site_Files_
RecentlyAddedFiles   

  MENU_View_Site_Files    Recently 
Changed Files  

  MENU_View_Site_Files_
RecentlyChangedFiles   

  MENU_View_Site_Files    Older Files    MENU_View_Site_Files_OlderFiles   

  MENU_View_Site    Shared Content    MENU_View_Site_SharedContent   

  MENU_View_Site_
SharedContent   

 Dynamic Web 
Templates  

  MENU_View_Site_SharedContent_
DynamicWebTemplates   

  MENU_View_Site_
SharedContent   

 Master Pages    MENU_View_Site_SharedContent_
MasterPages   

  MENU_View_Site_
SharedContent   

 Style Sheet 
Links  

  MENU_View_Site_SharedContent_
StyleSheetLinks   

  MENU_View_Site    Problems    MENU_View_Site_Problems   

  MENU_View_Site_Problems    Unlinked Files    MENU_View_Site_Problems_
UnlinkedFiles   

  MENU_View_Site_Problems    Slow Pages    MENU_View_Site_Problems_SlowPages   

  MENU_View_Site_Problems    Hyperlinks    MENU_View_Site_Problems_Hyperlinks   

  MENU_View_Site    Hyperlinks    MENU_View_Site_Hyperlinks   

  MENU_View    [Separator]    Separator_21   

  MENU_View    Visual Aids    MENU_View_VisualAids   

  MENU_View_VisualAids    Show    MENU_View_VisualAids_Show   
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 Parent   Menu Item   Internal ID  

  MENU_View_VisualAids    [Separator]    Separator_22   

  MENU_View_VisualAids    Block Selection    MENU_View_VisualAids_
BlockSelection   

  MENU_View_VisualAids    Visible Borders    MENU_View_VisualAids_
VisibleBorders   

  MENU_View_VisualAids    Empty 
Containers  

  MENU_View_VisualAids_
EmptyContainers   

  MENU_View_VisualAids    Margins and 
Padding  

  MENU_View_VisualAids_
MarginsAndPadding   

  MENU_View_VisualAids    CSS 
Display:none 
Elements  

  MENU_View_VisualAids_
CSSDisplayNoneElements   

  MENU_View_VisualAids    CSS 
Visibility:hidden 
Elements  

  MENU_View_VisualAids_
CSSVisibilityHiddenElements   

  MENU_View_VisualAids    ASP.NET Non-
visual Controls  

  MENU_View_VisualAids_
ASPNETNonVisualControls   

  MENU_View_VisualAids    ASP.NET 
Control Errors  

  MENU_View_VisualAids_
ASPNETControlErrors   

  MENU_View_VisualAids    Template 
Region Labels  

  MENU_View_VisualAids_
TemplateRegionLabels   

  MENU_View    Formatting 
Marks  

  MENU_View_FormattingMarks   

  MENU_View_
FormattingMarks   

 Show    MENU_View_FormattingMarks_Show   

  MENU_View_
FormattingMarks   

 [Separator]    Separator_23   

  MENU_View_
FormattingMarks   

 Tag Marks    MENU_View_FormattingMarks_TagMarks   

  MENU_View_
FormattingMarks   

 Paragraph 
Marks  

  MENU_View_FormattingMarks_
ParagraphMarks   

  MENU_View_
FormattingMarks   

 Line Breaks    MENU_View_FormattingMarks_
LineBreaks   

  MENU_View_
FormattingMarks   

 Spaces    MENU_View_FormattingMarks_Spaces   

  MENU_View_
FormattingMarks   

 Comments    MENU_View_FormattingMarks_Comments   

  MENU_View_
FormattingMarks   

 Script Blocks    MENU_View_FormattingMarks_
ScriptBlocks   

Table 36.3 Continued
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 Parent   Menu Item   Internal ID  

  MENU_View_
FormattingMarks   

 Positioned 
Absolute  

  MENU_View_FormattingMarks_
PositionedAbsolute   

  MENU_View_
FormattingMarks   

 Aligned 
Elements  

  MENU_View_FormattingMarks_
AlignedElements   

  MENU_View_
FormattingMarks   

 CSS Display: 
none  

  MENU_View_FormattingMarks_
CSSDisplayNone   

  MENU_View_
FormattingMarks   

 Hidden Form 
Fields  

  MENU_View_FormattingMarks_
HiddenFormFields   

  MENU_View    Quick Tag 
Selector  

  MENU_View_QuickTagSelector   

  MENU_View    [Separator]    Separator_24   

  MENU_View    Ruler and Grid    MENU_View_RulerAndGrid   

  MENU_View_RulerAndGrid    Show Ruler    MENU_View_RulerAndGrid_ShowRuler   

  MENU_View_RulerAndGrid    Show Grid    MENU_View_RulerAndGrid_ShowGrid   

  MENU_View_RulerAndGrid    Snap to Grid    MENU_View_RulerAndGrid_SnapToGrid   

  MENU_View_RulerAndGrid    [Separator]   Separator_25  

  MENU_View_RulerAndGrid    Set Origin from 
Selection  

  MENU_View_RulerAndGrid_
SetOriginFromSelection   

  MENU_View_RulerAndGrid    Reset Origin    MENU_View_RulerAndGrid_ResetOrigin   

  MENU_View_RulerAndGrid    [Separator]    Separator_26   

  MENU_View_RulerAndGrid    Configure...    MENU_View_RulerAndGrid_Configure   

  MENU_View    Tracing Image    MENU_View_TracingImage   

  MENU_View_TracingImage    Show Image    MENU_View_TracingImage_ShowImage   

  MENU_View_TracingImage    Configure...    MENU_View_TracingImage_Configure   

  MENU_View    Page Size    MENU_View_PageSize   

  MENU_View_PageSize    W x H Current 
Page Size  

  MENU_View_PageSize_DynamicLabel1   

  MENU_View_PageSize    [Separator]    Separator_27   

  MENU_View_PageSize    # [Page Size 
Setting]  

  MENU_View_PageSize_#   

  MENU_View_PageSize    [Separator]    Separator_28   

  MENU_View_PageSize    Modify Page 
Sizes...  

  MENU_View_PageSize_ModifyPageSizes   

  MENU_View    [Separator]    Separator_29   

  MENU_View    Toolbars    MENU_View_Toolbars   

  MENU_View_Toolbars    Standard    MENU_View_Toolbars_Standard   

  MENU_View_Toolbars    Formatting    MENU_View_Toolbars_Formatting   
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 Parent   Menu Item   Internal ID  

  MENU_View_Toolbars    Code View    MENU_View_Toolbars_CodeView   

  MENU_View_Toolbars    Common    MENU_View_Toolbars_Common   

  MENU_View_Toolbars    Dynamic Web 
Template  

  MENU_View_Toolbars_
DynamicWebTemplate   

  MENU_View_Toolbars    Master Page    MENU_View_Toolbars_MasterPage   

  MENU_View_Toolbars    Pictures    MENU_View_Toolbars_Pictures   

  MENU_View_Toolbars    Positioning    MENU_View_Toolbars_Positioning   

  MENU_View_Toolbars    Style    MENU_View_Toolbars_Style   

  MENU_View_Toolbars    Style 
Application  

  MENU_View_Toolbars_
StyleApplication   

  MENU_View_Toolbars    Tables    MENU_View_Toolbars_Tables   

  MENU_View    Refresh    MENU_View_Refresh   

  Table 36.4   Insert Menu Internal IDs  

 Parent   Menu Item   Internal ID  

 N/A   Insert    MENU_Insert   

  MENU_Insert    HTML    MENU_Insert_HTML   

  MENU_Insert_HTML    <div>    MENU_Insert_HTML_Div   

  MENU_Insert_HTML    <span>    MENU_Insert_HTML_Span   

  MENU_Insert_HTML    Break...    MENU_Insert_HTML_Break   

  MENU_Insert_HTML    Horizontal 
Line  

  MENU_Insert_HTML_HorizontalLine   

  MENU_Insert_HTML    Image    MENU_Insert_HTML_Image   

  MENU_Insert_HTML    Inline Frame    MENU_Insert_HTML_InlineFrame   

  MENU_Insert_HTML    Layer    MENU_Insert_HTML_Layer   

  MENU_Insert_HTML    Paragraph    MENU_Insert_HTML_Paragraph   

  MENU_Insert_HTML    [Separator]    Separator_30   

  MENU_Insert_HTML    More HTML 
Tags...  

  MENU_Insert_HTML_MoreHTMLTags   

  MENU_Insert    ASP.NET 
Controls  

  MENU_Insert_ASPNETControls   

  MENU_Insert_ASPNETControls    Button    MENU_Insert_ASPNETControls_Button   

  MENU_Insert_ASPNETControls    Checkbox    MENU_Insert_ASPNETControls_
Checkbox   

Table 36.3 Continued
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 Parent   Menu Item   Internal ID  

  MENU_Insert_ASPNETControls    Checkbox 
List  

  MENU_Insert_ASPNETControls_
CheckboxList   

  MENU_Insert_ASPNETControls    Dropdown 
List  

  MENU_Insert_ASPNETControls_
DropdownList   

  MENU_Insert_ASPNETControls    Image 
Button  

  MENU_Insert_ASPNETControls_
ImageButton   

  MENU_Insert_ASPNETControls    Label    MENU_Insert_ASPNETControls_Label   

  MENU_Insert_ASPNETControls    Listbox    MENU_Insert_ASPNETControls_Listbox   

  MENU_Insert_ASPNETControls    Radio Button    MENU_Insert_ASPNETControls_
RadioButton   

  MENU_Insert_ASPNETControls    Radio Button 
List  

  MENU_Insert_ASPNETControls_
RadioButtonList   

  MENU_Insert_ASPNETControls    Textbox    MENU_Insert_ASPNETControls_Textbox   

  MENU_Insert_ASPNETControls    [Separator]    Separator_31   

  MENU_Insert_ASPNETControls    Script 
Manager  

  MENU_Insert_ASPNETControls_
ScriptManager   

  MENU_Insert_ASPNETControls    Script 
Manager 
Proxy  

  MENU_Insert_ASPNETControls_
ScriptManagerProxy   

  MENU_Insert_ASPNETControls    Timer    MENU_Insert_ASPNETControls_Timer   

  MENU_Insert_ASPNETControls    Update 
Panel  

  MENU_Insert_ASPNETControls_
UpdatePanel   

  MENU_Insert_ASPNETControls    Update 
Progress  

  MENU_Insert_ASPNETControls_
UpdateProgress   

  MENU_Insert_ASPNETControls    [Separator]    Separator_32   

  MENU_Insert_ASPNETControls    More 
ASP.NET 
Controls...  

  MENU_Insert_ASPNETControls_
MoreASPNETControls   

  MENU_Insert    PHP    MENU_Insert_PHP   

  MENU_Insert_PHP    Form 
Variable  

  MENU_Insert_PHP_FormVaria  ble   

  MENU_Insert_PHP    URL 
Variable  

  MENU_Insert_PHP_URLVariable   

  MENU_Insert_PHP    Session 
Variable  

  MENU_Insert_PHP_SessionVariable   

  MENU_Insert_PHP    Cookie 
Variable  

  MENU_Insert_PHP_CookieVariable   

  MENU_Insert_PHP    [Separator]    Separator_33   

  MENU_Insert_PHP    Include...    MENU_Insert_PHP_Include   
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 Parent   Menu Item   Internal ID  

  MENU_Insert_PHP    Include 
Once...  

  MENU_Insert_PHP_IncludeOnce   

  MENU_Insert_PHP    Require...    MENU_Insert_PHP_Require   

  MENU_Insert_PHP    Require 
Once...  

  MENU_Insert_PHP_RequireOnce   

  MENU_Insert_PHP    [Separator]    Separator_34   

  MENU_Insert_PHP    Code Block    MENU_Insert_PHP_CodeBlock   

  MENU_Insert_PHP    Echo    MENU_Insert_PHP_Echo   

  MENU_Insert_PHP    Comment    MENU_Insert_PHP_Comment   

  MENU_Insert_PHP    If    MENU_Insert_PHP_If   

  MENU_Insert_PHP    Else    MENU_Insert_PHP_Else   

  MENU_Insert    [Separator]    Separator_35   

  MENU_Insert    Hyperlink...    MENU_Insert_Hyperlink   

  MENU_Insert    Bookmark...    MENU_Insert_Bookmark   

  MENU_Insert    Picture    MENU_Insert_Picture   

  MENU_Insert_Picture    From File...    MENU_Insert_Picture_FromFile   

  MENU_Insert_Picture    From Adobe 
Photoshop 
(.psd)...  

  MENU_Insert_Picture_
FromAdobePhotoshopPSD   

  MENU_Insert    Media    MENU_Insert_Media   

  MENU_Insert_Media    Flash 
Movie...  

  MENU_Insert_Media_FlashMovie   

  MENU_Insert_Media    Silverlight...    MENU_Insert_Media_Silverlight   

  MENU_Insert_Media    Silverlight 
Video...  

  MENU_Insert_Media_SilverlightVideo   

  MENU_Insert_Media    Deep Zoom...    MENU_Insert_Media_DeepZoom   

  MENU_Insert_Media    Windows 
Media 
Player...  

  MENU_Insert_Media_
WindowsMediaPlayer   

  MENU_Insert    Interactive 
Button...  

  MENU_Insert_InteractiveButton   

  MENU_Insert    Symbol...    MENU_Insert_Symbol   

Table 36.4 Continued

  note 
 It is not possible to add a new menu item before the Mark of the Web menu item on the Insert, HTML menu.   
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  Table 36.5   Format Menu Internal IDs  

 Parent   Menu Item   Internal ID  

 N/A   Format    MENU_Format   

  MENU_Format    New Style...    MENU_Format_NewStyle   

  MENU_Format    CSS Styles    MENU_Format_CSSStyles   

  MENU_Format_CSSStyles    Manage 
Styles...  

  MENU_Format_CSSStyles_ManageStyles   

  MENU_Format_CSSStyles    Apply Styles...    MENU_Format_CSSStyles_ApplyStyles   

  MENU_Format_CSSStyles    [Separator]    Separator_36   

  MENU_Format_CSSStyles    Attach Style 
Sheet...  

  MENU_Format_CSSStyles_AttachStyleSheet   

  MENU_Format_CSSStyles    Manage Style 
Sheet Links...  

  MENU_Format_CSSStyles_
ManageStyleSheetLinks   

  MENU_Format_CSSStyles    [Separator]    Separator_37   

  MENU_Format_CSSStyles    Style 
Application  

  MENU_Format_CSSStyles_StyleApplication   

  MENU_Format    CSS 
Properties...  

  MENU_Format_CSSProperties   

  MENU_Format    Tag 
Properties...  

  MENU_Format_CSSStyles_TagProperties   

  MENU_Format    [Separator]    Separator_38   

  MENU_Format    Font...    MENU_Format_CSSStyles_Font   

  MENU_Format    Paragraph...    MENU_Format_Paragraph   

  MENU_Format    Bullets and 
Numbering...  

  MENU_Format_BulletsAndNumbering   

  MENU_Format    Borders and 
Shading...  

  MENU_Format_BordersAndShading   

  MENU_Format    Position...    MENU_Format_Position   

  MENU_Format    Behaviors...    MENU_Format_Behaviors   

  MENU_Format    Layers...    MENU_Format_Layers   

  MENU_Format    [Separator]    Separator_39   

  MENU_Format    Dynamic Web 
Template  

  MENU_Format_DynamicWebTemplate   

  MENU_Format_
DynamicWebTemplate   

 Attach 
Dynamic Web 
Template...  

  MENU_Format_DynamicWebTemplate_
AttachDynamicWebTemplate   

  MENU_Format_
DynamicWebTemplate   

 Detach from 
Dynamic Web 
Template  

  MENU_Format_DynamicWebTemplate_
DetachFromDynamicWebTemplate   
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 Parent   Menu Item   Internal ID  

  MENU_Format_
DynamicWebTemplate   

 Open 
Attached 
Dynamic Web 
Template  

  MENU_Format_DynamicWebTemplate_
OpenAttachedDynamicWebTemplate   

  MENU_Format_
DynamicWebTemplate   

 [Separator]    Separator_40   

  MENU_Format_
DynamicWebTemplate   

 Update 
Selected Page  

  MENU_Format_DynamicWebTemplate_
UpdateSelectedPage   

  MENU_Format_
DynamicWebTemplate   

 Update All 
Pages  

  MENU_Format_DynamicWebTemplate_
UpdateAllPages   

  MENU_Format_
DynamicWebTemplate   

 Update 
Attached 
Pages  

  MENU_Format_DynamicWebTemplate_
UpdateAttachedPages   

  MENU_Format_
DynamicWebTemplate   

 [Separator]    Separator_41   

  MENU_Format_
DynamicWebTemplate   

 Manage 
Editable 
Regions...  

  MENU_Format_DynamicWebTemplate_
ManageEditableRegions   

  MENU_Format    Master Page    MENU_Format_MasterPage   

  MENU_Format_
MasterPage   

 Attach Master 
Page...  

  MENU_Format_MasterPage_
AttachMasterPage   

  MENU_Format_
MasterPage   

 Detach from 
Master Page  

  MENU_Format_MasterPage_
DetachFromMasterPage   

  MENU_Format_
MasterPage   

 Open 
Attached 
Master Page  

  MENU_Format_MasterPage_
OpenAttachedMasterPage   

  MENU_Format_
MasterPage   

 [Separator]    Separator_42   

  MENU_Format_
MasterPage   

 Manage 
Content 
Regions...  

  MENU_Format_MasterPage_
ManageContentRegions   

  MENU_Format    Frames    MENU_Format_Frames   

  MENU_Format_Frames    Split Frame    MENU_Format_Frames_SplitFrame   

  MENU_Format_Frames    Delete Frame    MENU_Format_Frames_DeleteFrame   

  MENU_Format_Frames    [Separator]    Separator_43   

  MENU_Format_Frames    Open Page in 
New Window  

  MENU_Format_Frames_OpenPageInNewWindow   

  MENU_Format_Frames    Save Page    MENU_Format_Frames_SavePage   

Table 36.5 Continued

37_9780789749192_ch36.indd   64237_9780789749192_ch36.indd   642 5/31/12   10:33 AM5/31/12   10:33 AM



643Menu and Command Bar Reference

36

C
H

A
P

TER

 Parent   Menu Item   Internal ID  

  MENU_Format_Frames    Save Page 
As...  

  MENU_Format_Frames_SavePageAs   

  MENU_Format_Frames    [Separator]    Separator_44   

  MENU_Format_Frames    Frame 
Properties...  

  MENU_Format_Frames_FrameProperties   

  MENU_Format    Background...    MENU_Format_Background   

  MENU_Format    Page 
Transition...  

  MENU_Format_PageTransition   

  MENU_Format    [Separator]    Separator_45   

  MENU_Format    Remove 
Formatting  

  MENU_Format_RemoveFormatting   

  MENU_Format    [Separator]    Separator_46   

  MENU_Format    Properties...    MENU_Format_Properties   

  Table 36.6   Tools Menu Internal IDs  

 Parent   Menu Item   Internal ID  

 N/A   Tools    MENU_Tools   

  MENU_Tools    Spelling    MENU_Tools_Spelling   

  MENU_Tools_Spelling    Spelling...    MENU_Tools_Spelling_Spelling   

  MENU_Tools_Spelling    Spelling 
Options...  

  MENU_Tools_Spelling_SpellingOptions   

  MENU_Tools    Thesaurus...    MENU_Tools_Thesaurus   

  MENU_Tools    Set Language...    MENU_Tools_SetLanguage   

  MENU_Tools    [Separator]    Separator_47   

  MENU_Tools    Accessibility 
Reports...  

  MENU_Tools_AccessibilityReports   

  MENU_Tools    Compatibility 
Reports...  

  MENU_Tools_CompatibilityReports   

  MENU_Tools    SEO Reports...    MENU_Tools_SeoReports   

  MENU_Tools    CSS Reports...    MENU_Tools_CSSReports   

  MENU_Tools    [Separator]    Separator_48   

  MENU_Tools    Add-Ins...    MENU_Tools_AddIns   

  MENU_Tools    [Separator]    Separator_49   

  MENU_Tools    Recalculate 
Hyperlinks...  

  MENU_Tools_RecalculateHyperlinks   
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 Parent   Menu Item   Internal ID  

  MENU_Tools    Optimize 
HTML...  

  MENU_Tools_OptimizeHTML   

  MENU_Tools    [Separator]    Separator_50   

  MENU_Tools    Application 
Options...  

  MENU_Tools_ApplicationOptions   

  MENU_Tools    Page Editor 
Options...  

  MENU_Tools_PageEditorOptions   

  Table 36.7   Table Menu Internal IDs  

 Parent   Menu Item   Internal ID  

 N/A   Table    MENU_Table   

  MENU_Table    Insert Table...    MENU_Table_InsertTable   

  MENU_Table    [Separator]    Separator_51   

  MENU_Table    Insert    MENU_Table_Insert   

  MENU_Table_Insert    Rows or Columns...    MENU_Table_Insert_RowsOrColumns   

  MENU_Table_Insert    [Separator]    Separator_52   

  MENU_Table_Insert    Column to the Left    MENU_Table_Insert_ColumnToTheLeft   

  MENU_Table_Insert    Column to the 
Right  

  MENU_Table_Insert_ColumnToTheRight   

  MENU_Table_Insert    [Separator]    Separator_53   

  MENU_Table_Insert    Row Above    MENU_Table_Insert_RowAbove   

  MENU_Table_Insert    Row Below    MENU_Table_Insert_RowBelow   

  MENU_Table_Insert    [Separator]    Separator_54   

  MENU_Table_Insert    Cell to the Left    MENU_Table_Insert_CellToTheLeft   

  MENU_Table_Insert    Cell to the Right    MENU_Table_Insert_CellToTheRight   

  MENU_Table_Insert    [Separator]    Separator_55   

  MENU_Table_Insert    Caption    MENU_Table_Insert_Caption   

  MENU_Table    Delete    MENU_Table_Delete   

  MENU_Table_Delete    Table    MENU_Table_Delete_Table   

  MENU_Table_Delete    Delete Columns    MENU_Table_Delete_DeleteColumns   

  MENU_Table_Delete    Delete Rows    MENU_Table_Delete_DeleteRows   

 MENU_Table_Delete   Delete Cells    MENU_Table_Delete_DeleteCells   

Table 36.6 Continued
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 Parent   Menu Item   Internal ID  

  MENU_Table    Select    MENU_Table_Select   

  MENU_Table_Select    Table    MENU_Table_Select_Table   

  MENU_Table_Select    Column    MENU_Table_Select_Column   

  MENU_Table_Select    Row    MENU_Table_Select_Row   

  MENU_Table_Select    Cell    MENU_Table_Select_Cell   

  MENU_Table    Modify    MENU_Table_Modify   

  MENU_Table_Modify    Merge Cells    MENU_Table_Modify_MergeCells   

  MENU_Table_Modify    Split Cells...    MENU_Table_Modify_SplitCells   

  MENU_Table_Modify    Split Table    MENU_Table_Modify_SplitTable   

  MENU_Table_Modify    Table 
AutoFormat...  

  MENU_Table_Modify_TableAutoFormat   

  MENU_Table_Modify    Distribute Rows 
Evenly  

  MENU_Table_Modify_
DistributeRowsEvenly   

  MENU_Table_Modify    Distribute Columns 
Evenly  

  MENU_Table_Modify_
DistributeColumnsEvenly   

  MENU_Table_Modify    AutoFit to 
Contents  

  MENU_Table_Modify_AutoFitToContents   

  MENU_Table    [Separator]    Separator_56   

  MENU_Table    Convert    MENU_Table_Convert   

  MENU_Table_Convert    Text to Table...    MENU_Table_Convert_TextToTable   

  MENU_Table_Convert    Table to Text    MENU_Table_Convert_TableToText   

  MENU_Table    Fill    MENU_Table_Fill   

  MENU_Table_Fill    Down    MENU_Table_Fill_Down   

  MENU_Table_Fill    Right    MENU_Table_Fill_Right   

  MENU_Table    [Separator]    Separator_57   

  MENU_Table    Table Properties    MENU_Table_TableProperties   

  MENU_Table_
TableProperties   

 Table...    MENU_Table_TableProperties_Table   

  MENU_Table_
TableProperties   

 Cell    MENU_Table_TableProperties_Cell   

  MENU_Table_
TableProperties   

 Caption...    MENU_Table_TableProperties_Caption   
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  Table 36.8   Site Menu Internal IDs  

 Parent   Menu Item   Internal ID  

 N/A   Site    MENU_Site   

  MENU_Site    New Site...    MENU_Site_NewSite   

  MENU_Site    Open Site...    MENU_Site_OpenSite   

  MENU_Site    Recent Sites    MENU_Site_RecentSites   

  MENU_Site    Close    MENU_Site_Close   

  MENU_Site    [Separator]    Separator_58   

  MENU_Site    Publishing    MENU_Site_Publishing   

  MENU_Site    Publishing 
Settings...  

  MENU_Site_PublishingSettings   

  MENU_Site    Publish Current 
File...  

  MENU_Site_Publish_Current   

  MENU_Site    Publish Changed 
Files...  

  MENU_Site_Publish_Changed   

  MENU_Site    Publish All 
Files...  

  MENU_Site_Publish_All   

  MENU_Site    [Separator]    Separator_59   

  MENU_Site    Delete...    MENU_Site_Delete   

  MENU_Site    Export to Web 
Package...  

  MENU_Site_ExportToWebPackage   

  MENU_Site    Import    MENU_Site_Import   

  MENU_Site_Import    Import from Web 
Package...  

  MENU_Site_Import_ImportFromWebPackage   

  MENU_Site_Import    Import Site 
Wizard...  

  MENU_Site_Import_ImportSiteWizard   

  MENU_Site    [Separator]    Separator_60   

  MENU_Site    Manage Sites 
List...  

  MENU_Site_ManageSitesList   

  MENU_Site    Site Settings...    MENU_Site_SiteSettings   
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  Table 36.9   Data View Menu Internal IDs  

 Parent   Menu Item   Internal ID  

 N/A   Data View    MENU_DataView   

  MENU_DataView    Insert Data 
View...  

  MENU_DataView_InsertDataView   

  MENU_DataView    Manage Data 
Sources...  

  MENU_DataView_ManageDataSources   

  MENU_DataView    [Separator]   Separator_61  

  MENU_DataView    Filter...    MENU_DataView_Filter   

  MENU_DataView    Sort.../Sort and 
Group...  

  MENU_DataView_DynamicLabel1   

  MENU_DataView    Separator    Separator_62   

  MENU_DataView    Edit Columns...    MENU_DataView_EditColumns   

  MENU_DataView    Change 
Layout...  

  MENU_DataView_ChangeLayout   

  MENU_DataView    [Separator]    Separator_63   

  MENU_DataView    Conditional 
Formatting...  

  MENU_DataView_ConditionalFormatting   

  MENU_DataView    [Separator]    Separator_64   

  MENU_DataView    Format Item as    MENU_DataView_FormatItemAs   

  MENU_DataView_
FormatItemAs   

 Text    MENU_DataView_FormatItemAs_Text   

  MENU_DataView_
FormatItemAs   

 Boolean    MENU_DataView_FormatItemAs_Boolean   

  MENU_DataView_
FormatItemAs   

 Number...    MENU_DataView_FormatItemAs_Number   

  MENU_DataView_
FormatItemAs   

 Currency...    MENU_DataView_FormatItemAs_Currency   

  MENU_DataView_
FormatItemAs   

 Date Time...    MENU_DataView_FormatItemAs_DateTime   

  MENU_DataView_
FormatItemAs   

 Label    MENU_DataView_FormatItemAs_Label   

  MENU_DataView_
FormatItemAs   

 [Separator]    Separator_65   

  MENU_DataView_
FormatItemAs   

 Hyperlink    MENU_DataView_FormatItemAs_Hyperlink   

  MENU_DataView_
FormatItemAs   

 Picture    MENU_DataView_FormatItemAs_Picture   

  MENU_DataView_
FormatItemAs   

 [Separator]    Separator_66   
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 Parent   Menu Item   Internal ID  

  MENU_DataView_
FormatItemAs   

 TextBox    MENU_DataView_FormatItemAs_TextBox   

  MENU_DataView_
FormatItemAs   

 Multiline 
TextBox  

  MENU_DataView_FormatItemAs_
MultilineTextBox   

  MENU_DataView_
FormatItemAs   

 Password 
TextBox  

  MENU_DataView_FormatItemAs_
PasswordTextBox   

  MENU_DataView_
FormatItemAs   

 Dropdown List    MENU_DataView_FormatItemAs_DropDownList   

  MENU_DataView_
FormatItemAs   

 List Box    MENU_DataView_FormatItemAs_ListBox   

  MENU_DataView_
FormatItemAs   

 Date Picker    MENU_DataView_FormatItemAs_DatePicker   

  MENU_DataView_
FormatItemAs   

 Check Box    MENU_DataView_FormatItemAs_CheckBox   

  MENU_DataView_
FormatItemAs   

 Check Box List    MENU_DataView_FormatItemAs_CheckBoxList   

  MENU_DataView_
FormatItemAs   

 Radio Button    MENU_DataView_FormatItemAs_RadioButton   

  MENU_DataView_
Format ItemAs  

 Insert Formula...    MENU_DataView_FormatItemAs_InsertFormula   

  MENU_DataView_
FormatIt emAs  

 Edit Formula...    MENU_DataView_FormatItemAs_EditFormula   

  MENU_DataView_
FormatIte mAs  

 [Separator]    Separator_67   

  MENU_DataView_
FormatItemAs   

 Refresh Data    MENU_DataView_FormatItemAs_RefreshData   

  MENU_DataView_
FormatItemAs   

 Data View 
Properties...  

  MENU_DataView_FormatItemAs_
DataViewProperties   

 To add a menu item to the Panels menu, create a Panel using the  <panel>  element in the manifest.  

  Table 36.10   Window Menu Internal IDs  

 Parent   Menu Item   Internal ID  

 N/A   Window    MENU_Window   

  MENU_Window    [Separator]    Separator_74   

  MENU_Window    Close All 
Pages  

  MENU_Window_CloseAllPages   

Table 36.9 Continued
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  Table 36.11   Help Menu Internal IDs  

 Parent   Menu Item   Internal ID  

 N/A   Help    MENU_Help   

  MENU_Help    User Guide    MENU_Help_ExpressionWebHelp   

  MENU_Help    Expression Web SDK 
User Guide  

  MENU_Help_SDKUserGuide   

  MENU_Help    [Separator]    Separator_74   

  MENU_Help    Online Community    MENU_Help_OnlineCommunity   

  MENU_Help_
OnlineCommunity   

 Expression 
Community Home  

  MENU_Help_OnlineCommunity_Home   

  MENU_Help_
OnlineCommunity   

 Expression Web 
Online Forums  

  MENU_Help_OnlineCommunity_
OnlineForums   

  MENU_Help_
OnlineCommunity   

 [Separator]    Separator_76   

  MENU_Help_
OnlineCommunity   

 Learn Expression 
Web  

  MENU_Help_OnlineCommunity_Learn   

  MENU_Help_
OnlineCommunity   

 Add-Ins Community 
Gallery  

  MENU_Help_OnlineCommunity_Gallery   

  MENU_Help_
OnlineCommunity   

 Microsoft Web 
Platform Installer  

  MENU_Help_OnlineCommunity_
PlatformInstaller   

  MENU_Help_
OnlineCommunity   

 [Separator]   Separator_77  

  MENU_Help_
OnlineCommunity   

 Expression Web 
Team Blog  

  MENU_Help_OnlineCommunity_TeamBlog   

  MENU_Help    Keyboard Shortcuts    MENU_Help_KeyboardShortcuts   

  MENU_Help    Privacy Statement    MENU_Help_PrivacyStatement   

  MENU_Help    [Separator]    Separator_78   

  MENU_Help    Customer 
Experience 
Improvement 
Program  

  MENU_Help_CustomerExperience   

  MENU_Help    Register Expression 
Web  

  MENU_Help_RegisterExpressionWeb   

  MENU_Help    Enter Product Key    MENU_Help_EnterProductKey   

  MENU_Help    Activate Product    MENU_Help_ActivateProduct   

  MENU_Help    [Separator]    Separator_79   

  MENU_Help    About Microsoft 
Expression Web  

  MENU_Help_AboutMicrosoftExpressionWeb   
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  Toolbars  
 The following tables list the internal IDs of all toolbars and toolbar buttons in Expression Web.  

  Table   36.12    shows the internal IDs on the Standard toolbar.  

  Table   36.13    shows the internal IDs on the Formatting toolbar.  

  Table   36.14    shows the internal IDs on the Code View toolbar.  

  Table   36.15    shows the internal IDs on the Common toolbar.  

  Table   36.16    shows the internal IDs on the Dynamic Web Template toolbar.  

  Table   36.17    shows the internal IDs on the Master Page toolbar.  

  Table   36.18    shows the internal IDs on the Pictures toolbar.  

  Table   36.19    shows the internal IDs on the Positioning toolbar.  

  Table   36.20    shows the internal IDs on the Style toolbar.  

  Table   36.21    shows the internal IDs on the Style Application toolbar.  

  Table   36.22    shows the internal IDs on the Tables toolbar.  

  Table 36.12   Standard Toolbar Internal IDs  

 Parent   Toolbar Button   Internal ID  

 N/A   N/A    COMMANDBAR_Standard   

  COMMANDBAR_Standard    New Document    COMMANDBAR_Standard_New   

  COMMANDBAR_Standard    New Site...    COMMANDBAR_Standard_NewSite   

  COMMANDBAR_Standard    Open...    COMMANDBAR_Standard_Open   

  COMMANDBAR_Standard    Save    COMMANDBAR_Standard_Save   

  COMMANDBAR_Standard    Save All    COMMANDBAR_Standard_SaveAll   

  COMMANDBAR_Standard    Find...    COMMANDBAR_Standard_Find   

  COMMANDBAR_Standard    [Separator]    Separator_16   

  COMMANDBAR_Standard    Publish the current 
file  

  COMMANDBAR_Standard_Publish_
Current   

  COMMANDBAR_Standard    Publish all changed 
files in your site  

  COMMANDBAR_Standard_Publish_
Changed   

  COMMANDBAR_Standard    Publish all files in 
your site  

  COMMANDBAR_Standard_Publish_All   

  COMMANDBAR_Standard    Get all changed files 
in your site  

  COMMANDBAR_Standard_Get_Changed   

  COMMANDBAR_Standard    Get all files in your 
site  

  COMMANDBAR_Standard_Get_All   
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 Parent   Toolbar Button   Internal ID  

  COMMANDBAR_Standard    Print    COMMANDBAR_Standard_Print   

  COMMANDBAR_Standard    Display in 
SuperPreview  

  COMMANDBAR_Standard_
OpenInSuperPreview   

  COMMANDBAR_Standard    Preview in Browser    COMMANDBAR_Standard_
PreviewInBrowser   

  COMMANDBAR_Standard    Spelling...    COMMANDBAR_Standard_Spelling   

  COMMANDBAR_Standard    [Separator]    Separator_19   

  COMMANDBAR_Standard    Cut    COMMANDBAR_Standard_Cut   

  COMMANDBAR_Standard    Copy    COMMANDBAR_Standard_Copy   

  COMMANDBAR_Standard    Paste    COMMANDBAR_Standard_Paste   

  COMMANDBAR_Standard    Format Painter    COMMANDBAR_Standard_FormatPainter   

  COMMANDBAR_Standard    [Separator]    Separator_20   

  COMMANDBAR_Standard    Undo    COMMANDBAR_Standard_Undo   

  COMMANDBAR_Standard    Redo    COMMANDBAR_Standard_Redo   

  COMMANDBAR_Standard    Insert Table    COMMANDBAR_Standard_InsertTable   

  COMMANDBAR_Standard    Insert Layer    COMMANDBAR_Standard_Layer   

  COMMANDBAR_Standard    Insert Picture from 
File  

  COMMANDBAR_Standard_FromFile   

  COMMANDBAR_Standard    [Separator]    Separator_22   

  COMMANDBAR_Standard    Insert Hyperlink    COMMANDBAR_Standard_Hyperlink   

  COMMANDBAR_Standard    Include Page...    COMMANDBAR_Standard_IncludePage   

  COMMANDBAR_Standard    [Separator]    Separator_23   

  COMMANDBAR_Standard    Refresh    COMMANDBAR_Standard_Refresh   

  COMMANDBAR_Standard    Stop    COMMANDBAR_Standard_Stop   

  COMMANDBAR_Standard    [Separator]    Separator_24   

  COMMANDBAR_Standard    Show formatting 
marks  

  COMMANDBAR_Standard_
ShowFormattingMarks   

  COMMANDBAR_Standard    [Separator]    Separator_25   

  COMMANDBAR_Standard    Expression Web Help    COMMANDBAR_Standard_
ExpressionWebHelp   
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  Table 36.13   Formatting Toolbar Internal IDs  

 Parent   Toolbar Button   Internal ID  

 N/A   N/A    COMMANDBAR_Formatting   

  COMMANDBAR_Formatting    Manage 
Styles...  

  COMMANDBAR_Formatting_ManageStyles   

  COMMANDBAR_Formatting    Style:    COMMANDBAR_Formatting_Style   

  COMMANDBAR_Formatting    Font:    COMMANDBAR_Formatting_Font   

  COMMANDBAR_Formatting    Font Size:    COMMANDBAR_Formatting_FontSize   

  COMMANDBAR_Formatting    [Separator]    Separator_26   

  COMMANDBAR_Formatting    Bold    COMMANDBAR_Formatting_Bold   

  COMMANDBAR_Formatting    Italic    COMMANDBAR_Formatting_Italic   

  COMMANDBAR_Formatting    Underline    COMMANDBAR_Formatting_Underline   

  COMMANDBAR_Formatting    [Separator]    Separator_27   

  COMMANDBAR_Formatting    Align Text 
Left  

  COMMANDBAR_Formatting_AlignLeft   

  COMMANDBAR_Formatting    Center    COMMANDBAR_Formatting_Center   

  COMMANDBAR_Formatting    Align Text 
Right  

  COMMANDBAR_Formatting_AlignRight   

  COMMANDBAR_Formatting    Justify    COMMANDBAR_Formatting_Justify   

  COMMANDBAR_Formatting    [Separator]    Separator_28   

  COMMANDBAR_Formatting    Increase Font 
Size  

  COMMANDBAR_Formatting_
IncreaseFontSize   

  COMMANDBAR_Formatting    Decrease Font 
Size  

  COMMANDBAR_Formatting_
DecreaseFontSize   

  COMMANDBAR_Formatting    [Separator]    Separator_29   

  COMMANDBAR_Formatting    Numbering    COMMANDBAR_Formatting_Numbering   

  COMMANDBAR_Formatting    Bullets    COMMANDBAR_Formatting_Bullets   

  COMMANDBAR_Formatting    Decrease 
Indent 
Position  

  COMMANDBAR_Formatting_DecreaseIndent   

  COMMANDBAR_Formatting    Increase 
Indent 
Position  

  COMMANDBAR_Formatting_IncreaseIndent   

  COMMANDBAR_Formatting    [Separator]    Separator_30   

  COMMANDBAR_Formatting    Borders    COMMANDBAR_Formatting_Borders   

  COMMANDBAR_Formatting    Highlight    COMMANDBAR_Formatting_Highlight   

  COMMANDBAR_Formatting    Font Color    COMMANDBAR_Formatting_FontColor   

  COMMANDBAR_Formatting    [Separator]    Separator_31   
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  Table 36.14   Code View Toolbar Internal IDs  

 Parent   Toolbar Button   Internal ID  

 N/A   N/A    COMMANDBAR_CodeView   

  COMMANDBAR_CodeView    List Members    COMMANDBAR_CodeView_ListMembers   

  COMMANDBAR_CodeView    Parameter 
Info  

  COMMANDBAR_CodeView_ParameterInfo   

  COMMANDBAR_CodeView    Complete 
Word  

  COMMANDBAR_CodeView_CompleteWord   

  COMMANDBAR_CodeView    List Code 
Snippets  

  COMMANDBAR_CodeView_ListCodeSnippets   

  COMMANDBAR_CodeView    [Separator]    Separator_49   

 C OMMANDBAR_CodeView    Follow Code 
Hyperlink  

  COMMANDBAR_CodeView_FollowCodeHyperlink   

  COMMANDBAR_CodeView    Previous 
Code 
Hyperlink  

  COMMANDBAR_CodeView_
PreviousCodeHyperlink   

  COMMANDBAR_CodeView    Next Code 
Hyperlink  

  COMMANDBAR_CodeView_NextCodeHyperlink   

  COMMANDBAR_CodeView    [Separator]    Separator_44   

  COMMANDBAR_CodeView    Function 
Lookup  

  COMMANDBAR_CodeView_FunctionLookup   

  COMMANDBAR_CodeView    [Separator]    Separator_45   

  COMMANDBAR_CodeView    Toggle 
Bookmark  

  COMMANDBAR_CodeView_ToggleBookmark   

  COMMANDBAR_CodeView    Next 
Bookmark  

  COMMANDBAR_CodeView_NextBookmark   

  COMMANDBAR_CodeView    Previous 
Bookmark  

  COMMANDBAR_CodeView_PreviousBookmark   

  COMMANDBAR_CodeView    Clear 
Bookmarks  

  COMMANDBAR_CodeView_ClearBookmarks   

  COMMANDBAR_CodeView    [Separator]    Separator_46   

  COMMANDBAR_CodeView    Select Tag    COMMANDBAR_CodeView_SelectTag   

  COMMANDBAR_CodeView    Find 
Matching Tag  

  COMMANDBAR_CodeView_FindMatchingTag   

  COMMANDBAR_CodeView    Select Block    COMMANDBAR_CodeView_SelectBlock   

  COMMANDBAR_CodeView    Find 
Matching 
Brace  

  COMMANDBAR_CodeView_FindMatchingBrace   

  COMMANDBAR_CodeView    [Separator]    Separator_47   
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 Parent   Toolbar Button   Internal ID  

  COMMANDBAR_CodeView    Insert Start 
Tag  

  COMMANDBAR_CodeView_InsertStartTag   

  COMMANDBAR_CodeView    Insert End 
Tag  

  COMMANDBAR_CodeView_InsertEndTag   

  COMMANDBAR_CodeView    Insert HTML 
Comment  

  COMMANDBAR_CodeView_InsertHTMLComment   

  COMMANDBAR_CodeView    Insert CSS 
Comment  

  COMMANDBAR_CodeView_InsertCSSComment   

  COMMANDBAR_CodeView    [Separator]    Separator_48   

  COMMANDBAR_CodeView    Options    COMMANDBAR_CodeView_Options   

  Table 36.15   Common Toolbar Internal IDs  

 Parent   Toolbar Button   Internal ID  

 N/A   N/A    COMMANDBAR_Common   

  COMMANDBAR_Common    New 
Document  

  COMMANDBAR_Common_New   

  COMMANDBAR_Common    New Site...    COMMANDBAR_Common_NewSite   

  COMMANDBAR_Common    Open...    COMMANDBAR_Common_Open   

  COMMANDBAR_Common    Save    COMMANDBAR_Common_Save   

  COMMANDBAR_Common    Save All    COMMANDBAR_Common_SaveAll   

  COMMANDBAR_Common    Display in 
SuperPreview  

  COMMANDBAR_Common_OpenInSuperPreview   

  COMMANDBAR_Common    Preview in 
Browser  

  COMMANDBAR_Common_PreviewInBrowser   

  COMMANDBAR_Common    [Separator]    Separator_6   

  COMMANDBAR_Common    Style:    COMMANDBAR_Common_Style   

  COMMANDBAR_Common    Font:    COMMANDBAR_Common_Font   

  COMMANDBAR_Common    Font Size:    COMMANDBAR_Common_FontSize   

  COMMANDBAR_Common    [Separator]    Separator_7   

  COMMANDBAR_Common    Undo    COMMANDBAR_Common_Undo   

  COMMANDBAR_Common    Redo    COMMANDBAR_Common_Redo   

  COMMANDBAR_Common    [Separator]    Separator_8   

  COMMANDBAR_Common    Bold    COMMANDBAR_Common_Bold   

  COMMANDBAR_Common    Italic    COMMANDBAR_Common_Italic   

Table 36.14 Continued
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 Parent   Toolbar Button   Internal ID  

  COMMANDBAR_Common    Underline    COMMANDBAR_Common_Underline   

  COMMANDBAR_Common    [Separator]    Separator_9   

  COMMANDBAR_Common    Align Text 
Left  

  COMMANDBAR_Common_AlignLeft   

  COMMANDBAR_Common    Center    COMMANDBAR_Common_Center   

  COMMANDBAR_Common    Align Text 
Right  

  COMMANDBAR_Common_AlignRight   

  COMMANDBAR_Common    [Separator]    Separator_10   

  COMMANDBAR_Common    Numbering    COMMANDBAR_Common_Numbering   

  COMMANDBAR_Common    Bullets    COMMANDBAR_Common_Bullets   

  COMMANDBAR_Common    Decrease 
Indent 
Position  

  COMMANDBAR_Common_DecreaseIndent   

  COMMANDBAR_Common    Increase 
Indent 
Position  

  COMMANDBAR_Common_IncreaseIndent   

  COMMANDBAR_Common    [Separator]    Separator_11   

  COMMANDBAR_Common    Borders    COMMANDBAR_Common_Borders   

  COMMANDBAR_Common    Highlight    COMMANDBAR_Common_Highlight   

  COMMANDBAR_Common    Font Color    COMMANDBAR_Common_FontColor   

  COMMANDBAR_Common    [Separator]    Separator_12   

  COMMANDBAR_Common    Insert Table    COMMANDBAR_Common_InsertTable   

  COMMANDBAR_Common    <div>    COMMANDBAR_Common_Div   

 C OMMANDBAR_Common    Insert Picture 
from File  

  COMMANDBAR_Common_FromFile   

  COMMANDBAR_Common    Insert 
Hyperlink  

  COMMANDBAR_Common_Hyperlink   

  COMMANDBAR_Common    Stop    COMMANDBAR_Common_Stop   

  Table 36.16   Dynamic Web Template Toolbar Internal IDs  

 Parent   Toolbar Button   Internal ID  

 N/A   N/A    COMMANDBAR_DynamicWebTemplate   

  COMMANDBAR_
DynamicWebTemplate   

 Regions:    COMMANDBAR_DynamicWebTemplate_
Regions   

  COMMANDBAR_
DynamicWebTemplate   

 Manage Editable 
Regions...  

  COMMANDBAR_DynamicWebTemplate_
ManageEditableRegions   
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 Parent   Toolbar Button   Internal ID  

  COMMANDBAR_
DynamicWebTemplate   

 Update Attached 
Pages  

  COMMANDBAR_DynamicWebTemplate_
UpdateAttachedPages   

  COMMANDBAR_
DynamicWebTemplate   

 Template Region 
Labels  

  COMMANDBAR_DynamicWebTemplate_
TemplateRegionLabels   

  Table 36.17   Master Page Toolbar Internal IDs  

 Parent   Toolbar Button   Internal ID  

 N/A   N/A    COMMANDBAR_MasterPage   

  COMMANDBAR_
MasterPage   

 Regions    COMMANDBAR_MasterPage_Regions   

  COMMANDBAR_
MasterPage   

 Manage Content 
Regions  

  COMMANDBAR_MasterPage_
ManageContentRegions   

  COMMANDBAR_
MasterPage   

 Template 
Region Labels  

  COMMANDBAR_MasterPage_
TemplateRegionLabels   

  Table 36.18   Pictures Toolbar Internal IDs  

 Parent   Toolbar Button   Internal ID  

 N/A   N/A    COMMANDBAR_Pictures   

  COMMANDBAR_
Pictures   

 Insert Picture from 
File  

  COMMANDBAR_Pictures_FromFile   

  COMMANDBAR_
Pictures   

 [Separator]    Separator_32   

  COMMANDBAR_
Pictures   

 Auto Thumbnail    COMMANDBAR_Pictures_AutoThumbnail   

  COMMANDBAR_
Pictures   

 [Separator]    Separator_33   

  COMMANDBAR_
Pictures   

 Bring Forward    COMMANDBAR_Pictures_BringForward   

  COMMANDBAR_
Pictures   

 Send Backward    COMMANDBAR_Pictures_SendBackward   

  COMMANDBAR_
Pictures   

 [Separator]    Separator_34   

  COMMANDBAR_
Pictures   

 Rotate Left 90°    COMMANDBAR_Pictures_RotateLeft90&#xb0;   

  COMMANDBAR_
Pictures   

 Rotate Right 90°    COMMANDBAR_Pictures_RotateRight90&#xb0;   

Table 36.16 Continued
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 Parent   Toolbar Button   Internal ID  

  COMMANDBAR_
Pictures   

 Flip Horizontal    COMMANDBAR_Pictures_FlipHorizontal   

  COMMANDBAR_
Pictures   

 Flip Vertical    COMMANDBAR_Pictures_FlipVertical   

  COMMANDBAR_
Pictures   

 [Separator]    Separator_35   

  COMMANDBAR_
Pictures   

 More Contrast    COMMANDBAR_Pictures_MoreContrast   

  COMMANDBAR_
Pictures   

 Less Contrast    COMMANDBAR_Pictures_LessContrast   

  COMMANDBAR_
Pictures   

 More Brightness    COMMANDBAR_Pictures_MoreBrightness   

  COMMANDBAR_
Pictures   

 Less Brightness    COMMANDBAR_Pictures_LessBrightness   

  COMMANDBAR_
Pictures   

 [Separator]    Separator_36   

  COMMANDBAR_
Pictures   

 Crop    COMMANDBAR_Pictures_Crop   

  COMMANDBAR_
Pictures   

 Set Transparent 
Color  

  COMMANDBAR_Pictures_SetTransparentColor   

  COMMANDBAR_
Pictures   

 Bevel    COMMANDBAR_Pictures_Bevel   

  COMMANDBAR_
Pictures   

 Resample    COMMANDBAR_Pictures_Resample   

  COMMANDBAR_
Pictures   

 [Separator]    Separator_37   

  COMMANDBAR_
Pictures   

 Select    COMMANDBAR_Pictures_Select   

  COMMANDBAR_
Pictures   

 Rectagular Hotspot    COMMANDBAR_Pictures_RectangularHotspot   

  COMMANDBAR_
Pictures   

 Circular Hotspot    COMMANDBAR_Pictures_CircularHotspot   

  COMMANDBAR_
Pictures   

 Polygonal Hotspot    COMMANDBAR_Pictures_PolygonalHotspot   

  COMMANDBAR_
Pictures   

 Highlight Hotspots    COMMANDBAR_Pictures_HighlightHotspots   

  COMMANDBAR_
Pictures   

 [Separator]    Separator_38   

  COMMANDBAR_
Pictures   

 Restore    COMMANDBAR_Pictures_Restore   
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  Table 36.19   Positioning Toolbar Internal IDs  

 Parent   Toolbar Button   Internal ID  

 N/A   N/A    COMMANDBAR_Positioning   

  COMMANDBAR_Positioning    Edit the posi-
tion property  

  COMMANDBAR_Positioning _ Position   

  COMMANDBAR_Positioning    Left    LABEL_COMMANDBAR_Positioning_Left   

  COMMANDBAR_Positioning    Top    COMMANDBAR_Positioning_Left   

  COMMANDBAR_Positioning    Top    LABEL_COMMANDBAR_Positioning_Top   

  COMMANDBAR_Positioning    Right    LABEL_COMMANDBAR_Positioning_Right   

  COMMANDBAR_Positioning    Bottom    LABEL_COMMANDBAR_Positioning_Bottom   

  COMMANDBAR_Positioning    Width    LABEL_COMMANDBAR_Positioning_Width   

  COMMANDBAR_Positioning    Height    LABEL_COMMANDBAR_Positioning_Height   

  COMMANDBAR_Positioning    Z-Index    LABEL_COMMANDBAR_Positioning_Zindex   

  COMMANDBAR_Positioning    Bring Forward    COMMANDBAR_Positioning_BringForward   

  COMMANDBAR_Positioning    Send Backward    COMMANDBAR_Positioning_SendBackward   

  Table 36.20   Style Toolbar Internal IDs  

 Parent   Toolbar Button   Internal ID  

 N/A   N/A    COMMANDBAR_Style   

  COMMANDBAR_Style    Class:    LABEL_COMMANDBAR_Style_Class   

  COMMANDBAR_Style    ID:    LABEL_COMMANDBAR_Style_ID   

  COMMANDBAR_Style    New Style...    COMMANDBAR_Style_NewStyle   

  COMMANDBAR_Style    Attach Style Sheet...    COMMANDBAR_Style_AttachStyleSheet   

  Table 36.21   Style Application Toolbar Internal IDs  

 Parent   Toolbar Button   Internal ID  

 N/A   N/A    COMMANDBAR_StyleApplication   

  COMMANDBAR_
StyleApplication   

 Target Rule:    LABEL_COMMANDBAR_StyleApplication_
TargetRule   

  COMMANDBAR_
StyleApplication   

 Reuse 
Properties  

  COMMANDBAR_StyleApplication_
ReuseProperties   

  COMMANDBAR_
StyleApplication   

 Show Overlay    COMMANDBAR_StyleApplication_ShowOverlay   
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  Table 36.22   Tables Toolbar Internal IDs  

 Parent   Toolbar Button   Internal ID  

 N/A   N/A    COMMANDBAR_Tables   

  COMMANDBAR_Tables    Column to the 
Left  

  COMMANDBAR_Tables_ColumnToTheLeft   

  COMMANDBAR_Tables    Column to the 
Right  

  COMMANDBAR_Tables_ColumnToTheRight   

  COMMANDBAR_Tables    Row Above    COMMANDBAR_Tables_RowAbove   

  COMMANDBAR_Tables    Row Below    COMMANDBAR_Tables_RowBelow   

  COMMANDBAR_Tables    Delete Cells    COMMANDBAR_Tables_DeleteCells   

  COMMANDBAR_Tables    [Separator]    Separator_39   

  COMMANDBAR_Tables    Merge Cells    COMMANDBAR_Tables_MergeCells   

  COMMANDBAR_Tables    Split Cells...    COMMANDBAR_Tables_SplitCells   

  COMMANDBAR_Tables    [Separator]    Separator_40   

  COMMANDBAR_Tables    Align Top    COMMANDBAR_Tables_AlignTop   

  COMMANDBAR_Tables    Center 
Vertically  

  COMMANDBAR_Tables_CenterVertically   

  COMMANDBAR_Tables    Align Bottom    COMMANDBAR_Tables_AlignBottom   

  COMMANDBAR_Tables    [Separator]    Separator_41   

  COMMANDBAR_Tables    Distribute 
Rows Evenly  

  COMMANDBAR_Tables_DistributeRowsEvenly   

  COMMANDBAR_Tables    Distribute 
Columns 
Evenly  

  COMMANDBAR_Tables_DistributeColumnsEvenly   

  COMMANDBAR_Tables    AutoFit to 
Contents  

  COMMANDBAR_Tables_AutoFitToContents   

  COMMANDBAR_Tables    [Separator]    Separator_42   

  COMMANDBAR_Tables    Fill Color    COMMANDBAR_Tables_FillColor   

  COMMANDBAR_Tables    [Separator]    Separator_43   

  COMMANDBAR_Tables    Table 
AutoFormat 
Combo  

  COMMANDBAR_Tables_TableAutoFormatCombo   

  COMMANDBAR_Tables    Table 
AutoFormat  

  COMMANDBAR_Tables_TableAutoFormat   
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